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Last time:
Tonight:

e ...when, where, why, who,
what?

» Syllabus
* Projects
» Assignment 1
* Intro to Pro/Engineer
* How to get around

 File management

Tonight:
 Creating models in Pro/Engineer:

e Customizing and formatting the Pro/E
environment

e Introduction to Datums
« Sketcher
 Solid feature creation
« Extrude
* Revolve

* There’s going to be a lot of click-along




Key TLA'S
 LMB — Left mouse button

« MMB — Middle mouse button
« RMB — Right mouse button




Standardizing and customizing Pro/E
« Many aspects of Pro/Engineer can be customized
* Decimal places, system colors, default templates, etc.
* These can be BIG time savers
» User settings are stored in a series of files
 config.pro — General preferences and “mapkeys” (macros)
 config.win.X — Pro/Engineer window settings
» drawing.dtl — Detailed drawing parameters
» tree.cfg — Model tree configurations
o All of these files are read out of the launch directory at startup

* We need to create and specify this directory to set preferences




EXERCISE - Create a desktop icon for Pro/E

@ Mozilla Firefox
. Commen Apps
. Electrical
1 IE Favorites Migration
o Struct + Mech
. Abaqus610-EF2
|. Bentley

. Bentley Engineering
. Computers and Structures
\ Lingo
i PTC
B PTC ProDESKTOP 8.0
0 Pro ENGINEER

I ModelCHECK

| Distributed Pro BATCH

I@| Pro ENGINEER

.I-E_] Structure
@ Thermal
1 SolidWarls 2011

| Search progroms and files

Burke, Brian C.
Documents
Pictures

Music
Computer

Control Panel

Dleanicer and Drinkare

Help and Support

1-Zip
Copy here
Move here

Create shortcuts here

Cancel




EXERCISE - Specify launch directory

1. Make sure directory exists

Organize = Sync - Burn

‘1 Recent Places

= Libraries
3 Documents
& Music
[ Pictures
B videos

1% Computer
a System (C:)
a Data (D)
—a My Passport (E:)
L apps (hen-file] (P:)
—a Ypdates (T3]
& burkebe (Wen-filelusers) (Lk)
abaqus_plugins

i‘ | M' [Documents

. Profile
B tmp
I W

Work

Troubleshoot compatibility

Open file location
Run as administrator
7-Zip

Scan with Microsoft Security Essentials...

Pin to Taskbar
Pin to Start Menu

Always available offline

Sync

Restore previous versions
Send to

Cut

Copy

Create shortcut
Delete

Rename

Properties

Details Previous Yersions | Cffline Files

General Shorteut Compatibilty |  Security

2. Edit properties
of desktop icon

@ Pro ENGINEER

Tanget type: Application

Target location: bin

3. Specify “Start
Target: gram Fie ;" directory

EtartC U-prog )

Shorcut key:  Mone

Bun: INanaJ window YI

Comment:

Open File Location ]Iglaﬂgelmn Il Advanced. .. l

4. Accept




PLEASE LAUNCH PRO/E NOW
FROM DESKTOP ICON

Why are we doing this?

* If we don't standardize the format for parts drawings and
assemblies we’ll have to repeat steps every time Pro/E is

launched

* Allows users to customize the working environment and

graphic user interface

« BOTH OF THESE SHOULD BE TIME SAVERS




EXERCISE - Specifying configuration options

» To begin, open the part we used last class,

piston.prt
 Remember to set working directory!

I PISTON {Active) - Pro/ENGINEER Education Edition =10l x|
File Edit Yiew Insert Analysis Iofo Applications Tools Window Help
DecoageveimmpEmnc-llOFFgaaas sk oo o0
e
&l
&l

 File > Open piston.prt

RIGHT

Smart




EXERCISE - Specifying configuration options

I PISTON {Active) - Pro/ENGINEER Education Edition

Tools > Options brings up the options

£ J=l E Relations. .. J 5 + d H I b
JDEBC&%JQO% Parameters. .. E}‘%Q&@L} Iaog OX
Lo Designate, .,
7l H, J A2
H AR Family Tahle. .. _
‘ Program... x]
LIDF Library. .. Showing: Sort:
§‘” %l é‘"ﬁ' % Image Editor... ICunentSession j B’_" | ;[g] | IAIphabeticaI j
Show | Settings ¥ | Upelaiz flfg 425 IV Shaw only options loaded from file
TMaodel Pl
I e . Walue |Status |Source
7] PISTOM.PRT Assembly Settings
i RIGHT
g TOP ﬁﬂ Play Trail{Training File. ..
£ 7 FRONT Eij Distributed Computing.. .
-1 Protrusion id 14 Profiieb.Link
e P
E.; Inuselrt Here Floating Modules
Auxiliary Applications
. Environment
Server Manager...
Cuskomize Screen...
Configure ModelCHECK
Ear Histary
4
» Options
Edit and Load a configuration file il —’I-—‘I—I _’I
DOption: Walue:
[ [ =] [ add i Change |
& Find... | Browse... | [Ielete |
o | st




EXERCISE - Specifying configuration options

Shawing
I Cumrent Session 1, Type kepward

¥ Show only opti Ishaded

I: Lock in: | ALL_CATEGORY

[~ Search dezcriptions

x|

" |

2. Chooze option

Mame

drawing_shaded_wview_dpi
enable_shaded_view_in_drawings
shaded_postscript_backarg
show_shaded edges

D escription

Resalution of exported shaded drawing views. The range of walid values iz 0 to 600 dots
‘Y'es - shading dizplay is allowed in drawing wiews. Mo - shading display will be shawn in w
Specifies how background colars are handled in Postscript files of shaded objects.
Contrals the edge color when shading. es - Edges are dizplayed in darker calor than the

ﬂ Browse... |

Cloze ‘

Add / Change | ‘

Find Mow .

@ Click Find on Options Dialog
- @ Enter “shaded”

@ Click Find Now

@ Sclect “show_shaded_edges”
- @ Change Set Value to “yes”
@ Click Add/Change

@ Click Close




EXERCISE - Specifying configuration options

x|
Showing: Sork;
I Cument Session j E_]'j I Ailphabetical j
¥ Show only options loaded from file
alue I Statuz I Source
Current Session
f E ZES 0

———,

File name: Date modified:
Kl
File name: | config. pro ‘ T_l,lpel Configure File ﬂ
Option:
l_ Folder Tree - Ok | - Cancel I

O e

= I [0« usershburkebe on ‘'endfile’ (U] » My Documents » pros »

.JJJ Organize ~  E2 Views
Common Folders [(inclass
m Degktop

2 My Documents

% working Directory

@ Favorites

0|

x|

- | 3 ISearch...

Q4 Find... |

Browse... |

[elste |

ak I Appl_l,ll Elosel

@ Back at Options Dialog, Click

@ Save a Copy Icon

@ Enter “config.pro” for file name
Click Ok
MAKE SURE YOU'RE IN THE
...\proe DIRECTORY




What did that option do?

I (=] 3} ENGINEER Education Edition =lOol x|
analysis  Info  Applications  Tools  window  Help |
lErgaans tsk)e o oo gllocyecriEnc- O amstsRk|e o o/0]
[

i

L
=

Edges are a
different color than
shaded surfaces

E & @

=R G

i
Ry
3
L1 |
= Eff
] ICHT =
o =
= -

< J 0 ::[

E & @

i

L
=




Introduction to Datum Features
Datums are spatial features that locate a component or assembly in a
coordinate system

Datums can have significance beyond building the CAD model

» Engineering Drawings and Quality Inspections
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Datum Tools

Bl TEST (Active) - Pro/ENGINEER Education Edition

B % L

Visibility

_________
----------------

Er |
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EXERCISE - Create a new part file

» Create a new subfolder within U:\proe called “inclass”

» Set working directory
 File > Set Working Directory > Choose U:\proe\inclass

x4
e Create a new part —, . P
e File > New > " P Sketch * Solid
r:\. P £ R ==y =L | )
< O Par - " Sheetmetal
- = ey " Bulk
° Name flle ext-rev i, Manufactuing = Harmess
i Dratwinig
|4 Fomat
' [] Repott
" =L Diagram
3] Layout
i @ b arkup
—
Hame e:-:t-rex-{ )
Common Mame
¥ Use default template
Cancel |
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EXERCISE — Turn Datum Planes on and off

il TEST (Active) - Pro/ENGINEER Education Edition
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EXERCISE — Create an Datum AXIS

e T —
File Edit Wiew Insert Analysis Info & ns Took ‘Window Help P‘GCEmEmlD\sp\ayl Prupenies|
| |\l%ﬁ|nmﬂ“ B n OB R AT e
| T | e FRONT-FADATUM PL.. Thiough
e =

RIGHT:F1[DATUM PL.. Through

==
M@@m
Show~ | Settings ~ |

:_IT

rrrrrr

Offset raf ferences

2aeonde? %9y,

| (|

‘aa@?@d

Click on Datum Axis Tool

Click on the RIGHT Datum Plane
Holding the Ctrl key, Click on the

FRONT datum plane

Verify FRONT and RIGHT are the
references

Click Ok

Turn the Datum Axis on and off

with the Axis Display tool

NOTE: Steps 1-5 can be also be done by performing steps 2, 3, 1 (in that order)




Majority of 3D geometric features are created through
two types of processes...

il

EarRlO-SacEs teweeal )

L ‘ : s o o
; P R R EEEIE]

4

"o [r]x

‘aa@?\@ dl.ﬂ@\ﬂ % B K e R~

RRR

Extrude Revolve

BCB — Jan. 31, 2012 EN1740, S2012



S -
mm  Brown University

....which are defined using 2D sketches

Sketch features used as bases for these and
many other 3D features
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EXERCISE - 2D sketches are created in Sketcher Mode

* There are a number of ways to launch Sketcher

e To start, we'll make a stand-alone sketch
I =5

3 Window Help Placement | P[opertiesl
%ﬁ@mgqﬁﬁﬁaa@@WSWF
TOPF2DATU.  Use Previous |

fiewy orientation.

Sketch Orisntation
Sketchadizw direction  Flip |

Refe RIGHT:F1[DATUM PLAME)
Orientation I Fiight 'l

Cancel

@ CcClick on Sketch Tool

@ Click on “Top” datum plane

@ Make sure “TOP:F2..." is the
Plane

@ Make sure “RIGHT:F1..." is the
Reference

® Click Sketch to continue

BCB - Jan. 31, 2012

EN1740, S2012



EXERCISE — Welcome to sketcher

B TEST {Active) - Pro/ENGINEER Education Edition =131 x|

File Edit View Insert 3Sketch Analysis Info  Applicstions Tools Window Help

D@Ulﬁb%Hnﬂéﬁ\%It&i’_ [Brgaanstsh|esoo|alzkxE
QT T ET TG ;

elec ice, such as surface, plane or edge to define view orientation.

=
Sketcher Toolbar

g | & |z | &R

Stgw - | Setings~ | : Seledt ftems | &
[J TEST.PRT O Line Types | ™
Rectangle |
© GrdeTypes [ @ (O (O ©
: AreTypss |y~ &y DY Y 2
,'\v FII!eISTy;pes A vu-’i
pline |y
* Point / (sys :-,I:
.I: Entity from Edge Types | O vﬂ
l_J Dimension || |
:f Madify Values | =
2 Constraints | [T
N Texd | T
Q Sketcher Palette (:g
-S:i Trim Types | S8 w i (&
| Mirror/Move-Rotate/Copy | 03y ~| &)
v Complete Sketch | w~ '
X Concel Sketch | X




EXERCISE — Draw a Center-Point circle

B EXT-REY {Active) - Pro/ENGINEER Education Edition |0 il

File Edit Wiew Insert Sketch Analysis Info Applications Tools Window Help | . .
|cueazlecsasts o-gacmsroalsasllassxbl | @ Click on Center and Point
[Erfvalz]z o o e v]

o Select the center of a circle.
® yithen constraint is displayed: Right dlick to disable it. Press Shift + right click to lock it. Use Tab key to boggle ackive constraint.

g |2 G| 58|
Shy

o ¥ | Settings = |

Icon

|

@ LMB a center point location

(] EXT-REV.PRT
-4 RIGHT
D’ TOP
77 FRONT
5§« FRT_C5¥S_DEF
A_L

@ LMB at a point on the circle

e 00/~

P
& Insert Here
e $25ketch 1

(i.e. at the correct

10 =

diameter)
@ MMB to end creation

LS RE AN

X




EXERCISE — Constrain Circle

@ EXT-REV (Active) - Pro/ENGINEER Education Edition

File Edit ‘iew Insert Sketch Analysic Info Applications Tools Window Help ‘ C“Ck On C On Str al n ts
EEEEE N E e A= RN e =T

EEEEEEE T EIEE

o Select the center of a circle.
® when constraint is displayed: Right click to disable it. Press Shift + right: click to lock it, Use Tab key to toggle active constraint,

@ In Constraints Pop-up, Click

kel ml on Coincident
== | N | &
o .- @ LMB on circle’s center point
EEEE%EE?_N;SVS_DEF '3 : :"x .
> @ LMB on RIGHT datum plane
&

] =

@ LMB on circle’s center point
@ LVB on FRONT datum plane
@ VMB to end

X<E%Q§ﬂ!l

@ Close Constraints Pop-up




EXERCISE — Dimension Circle

B EXT-REY (Active) - Pro/ENGINEER Education Edition =10 il

File Edit Miew Insert Sketch Analysis Iofo Applications Tools Window Help | - H M

[fznacileasnpinc-|Or-Faaadstan|oaalo]z sk ‘ Double-click on diameter
R A A _ _
::elect two entities or vErtc‘es to align. ‘ ‘ ‘ 2l d I m e n S I O n

B | %) 4R

Show = | Settings = | . g ‘ Enter .500
] EXT-REV.PRT ;:
i -~ @ Enter or MMB

3 PRT_C545_DEF
At

s

PR
& Insert Here
ST TESkekch |

@ Click on Done

S B

1 selected All - ‘ %
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EXERCISE — Done

Press Ctrl+D to see the default view of the sketch just completed

BCB — Jan. 31, 2012 EN1740, S2012



Sketcher Notes — Constraints

: Make two vertices or a
Make two vertices or line entity horizontal

Make two line entities

a line entity vertical
Make a circle or arc \

tagent to another entity

Make a portion of a sketch
symmetric (mirror)

perpendicular

Make two entities
colinear or coincident

Create a mid-point on entity

Make two line entities
parallel

Make radius, diameter or
length of two entities equal

Help is available if you
need it




Sketcher Notes — Strong and Weak Dimensions

STRONG dimensions appear in
YELLOW. These dimensions
have been identified by the users
as being critical to design intent.

Weak dimensions appear in
GRAY. These dimensions are
assumed by Pro/E
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Extrude sketch to create 3D model

@ Click on sketch in the
graphic window
@ Click on the Extrude tool

BCB — Jan. 31, 2012 EN1740, S2012



Solid Feature Dashboard

Il EXT-RE¥ {Active) - Pro/ENGINEER Education Edition

File Edit Yiew Insert Analvsis Info  Applications Tools ‘Window Help

| m "lﬁa%]ﬂﬂa’a\%f—‘ Hlla-gaadstehm|oaao
L

I-':['_"J - s =]

' —=
[ I= S T AN I I Moo [v] X >
Iau:ement| Optionz  Properties

.g’il_f%liléﬁl The Dashboard |

\

- Q

[T EXT-REY.PRT | ﬁ
- RIGHT -
T TOR ==

- 7 FRONT f*’@‘
§§~ PRT_CSVS_DEF i
e : &1

. oy Insert Here
By ! B Extrude 1

%
=
_ :.-"
(e

i
T
--.J 3 i
B
(=)
i
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Extrude sketch to create 3D model

Il EXT-RE¥ {Active) - Pro/ENGINEER Education Edition

File Edit Yiew Insert Analvsis Info  Applications Tools ‘Window Help

EEE&sGe|vay bEE2RE] || B-rFRAC S 2R 68068 0

AR AL

;57 =
[ ly=0 TS P A N 1l
Flacement | Options  Properties -

Click Done or MMB

to complete feature
[] EXT-REY.PRT S

- £ F RIGHT o
- TOP

I
] x
f &

- F FRONT Iz
§§~ PRT_CSYS_DEF | =
e a1

= 1

. oy Insert Here
By ! B Extrude 1
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Solid Feature Dashboard

Solid

Done

v

Depth
: Depth
Surface Options Value
o i W=l TSRS CETRES (A 4
‘ F'l-:II_ZI:IIII:rIl| Oplioriz Fropeilies
Pause
| EdN= =
Preview

X

Quit




EXERCISE - Make the same solid with a REVOLVE

Done.

B EXT-REY {Active) - Pro/ENGINEER Education Edition

File Edit ‘ew Inserk Analysis Info Applications Tools  Window Help
BEEEEEEEY Y T ET
a2 x|

® Regeneration completed with 2 suppressed featureis) or component(s).
® Feature redefined successFully,
o Seleck a sketeh, (IF an internal skekch is preferred, the "Edit” option can be Found in the Placement panel.)

Bo | & | | SR

Show | Seflings ™ |

[Ergacattem|eo ald]

L

(1 EXT-REY.PRT
£ F RIGHT
. U TOP
£7 FRONT
5§« PRT_CS¥S_DEF
o S

oo el
Lo Insert Here

I Smart | 1"”%
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EXERCISE - Make the same solid with a REVOLVE

Create a sketch

» Sketch on the FRONT
datum

» Use RIGHT datum as
Reference

BCB — Jan. 31, 2012 EN1740, S2012



EXERCISE - Make the same solid with a REVOLVE

Il EXT-REY¥ (Active) - Pro/ENGINEER Education Edition = lﬂlﬂ

Eile Edit Wew Insert Sketch Analysis Info - Applications Tools  window Help

gzl isi|ee

| 2 colach | sketch is preferred, the "Edit" option can be found in the Placement panel.)

efine sketch plane.

A Revolve requires an axis of  prossesssms e
revolution. This is done with
the FIRST centerline drawn in
the sketch.

Sketch a centerline aligned
with the RIGHT datum plane

________________________________________

‘XQE%QIEHH

|
|
Creats 2 paink centetlines, | l Al "I | g - @ EII
d;start| (7 Lecture | |5 pros | kel 020210 _lecturs? ppt [... | (€ EN1740 - Home - Windo., .. ||[j EXT-RE¥ (Active) - Pr... T WF4QRC-Wweb.pdf - Ad.., | T ledl 7:39PmM




EXERCISE - Make the same solid with a REVOLVE

Sketch rectan g le and dimension 8 EXT REY (i) Pro/ENGINER EdcotionEiion

Fle Edit View Insert Sketch Analysis Info Applications Tools Window Help

=10l x|

) L ) EEEEE N T T E R === R eI
* Align (Coincident Constraint) [z .z @ aﬂ EETEED

* When col is displayed: Right click ko disable it. Press Shift + ght click ko lackit. Use Tab key to toggle active constraint.
o> Select items such as Dimensions, Sections, Tra jectories, Tol \ aaaaaaaaaaaaaaaaaaa h or other features for editing
to RIGHT and TOP datum P :
e |%| gl
I | Settings
planes —
-7 RIGHT
£F TP
" =7 FROMT
e Height > .250 Fene
" i
= Insert Here
3 sketch

* Diameter > .500
NOTE: To dimension a diameter >
1. Click Centerline

Click Diameter

erlon=-]
D;ﬂ

10 =
% B K

X4 = ®_E SRV

-1 §

2
3. Click Centerline again
4, MMB

Click Done
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EXERCISE - Make the same solid with a REVOLVE

With same sketch highlighted

* Click Revolve
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EXERCISE - Make the same solid with a REVOLVE
Dashboard for REVOLVE is almost the same as EXTRUDE with a few exceptions

File Edit Wew Insert Analysis Info  Applications Tools  Window  Help

Pick a centerline to
revolve about

EEEEEE e ER R

G a2 R | %2

ﬁ’:.;% Mtch. (IF an interpal sketch is preferred, the "

X
X

dit" option can be Found in the Placement panel.)

Number of degrees to
[ ] EXT-REV.FRT
revolve through | - £7 RIGHT

.5{% SR evalve 1




EXERCISE - Make the same solid with a REVOLVE

Done, again.

B EXT-REY (Active) - Pro/ENGIMEER Education Edition

File Edit “ew Insett Analysis Info Applications Tools Window Help
EEE R
[a 7 sl

-
® Regeneration completed with 2 suppressed Featureis) or component(s), _I
* Feature redefined successfully,

o2 Select a sketch. (IF an internal sketeh is preferred, the "Edit” option can be Found in the Placement panel.)

8o |& | 3| &Rl

Show ¥ | Settings |

[Zrgaaas tok|eo ald]

(71 EXT-REV.PRT
7 RIGHT
U TOP
-7 FRONT
3§« PRT_CS¥S_DEF
1

Skakch 2
i Revolve 1
- Inserk Here

I Smart "?” i;
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Pro/E Layout and Iconology

Main Toolbar

CaYRBEIEFRNG- DrFVAARO SN 6000

Undo Cut Regenerate Model © Repaint Drog Component Reorient View : Wireframe

Redo Copy Regeneralive Manager  © Spin Center Toom In Saved Views - tildden line
Paste Search Tool * Orient Mode Toom Out Layers © No Hidden
Paste Spedal Selection Types ! Refit View Munager  Shading

Model Display

I it |

@ BATTERY (Active) - Pro/ENGIMNEER Education Edition

File Edit ‘iew Insert  Anakysis

Info  Applications  Tools  Window  Help

=Ny Yel

| o o ¥ Be 3 B ES -

=N=NallE)

|E% & Q& O S

EEER

- Plane
" s
Palnt
- Coordinate System
- Annofations

| AR EAR

Datum Disploy

o | & | G | SR

Show * | Settings ™ |

1 BATTERY.PRT
b RIGHT

47 FRONT

------ A4 PRT_CSYS_DEF

L. o Insert Here
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Pro/E Layout and Iconology

Feature Creation Toolbar

" ﬂuTum Sketch |2
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